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Introduction
TCDView is a composite document viewer. It allows to collect a set of raster or vector documents
into a single composite document. Individual drawings in the composite document can be
selected to allow changing of their parameters, their position in common world coordinates and
their visible areas (viewports). The current coordinates of the mouse cursor in the composite
document world are displayed in the status bar. It is also possible to measure distances between
selected points. TCDView can print composite documents. Composite documents are stored
in files with the TCD (Tessel Composite Document) extension and can also be embedded
in other documents. Composite documents currently contain references to document files but
do not contain document files themselves. Composite documents are especially useful in GIS
applications for seamless display of neighbouring or overlapping sections of raster and vector
maps.

TCDView displays composite documents that refer to document files saved in various raster
and vector formats. The full list of formats supported by TCDView can be found in the section
called “Appendices” at the end of this manual. File names of raster and vector documents must
have extensions appropriate for their formats. Several composite documents can be open in one
TCDView session. You may arrange the positions and sizes of windows, as to view all or selected
documents that are open in the session.

Individual documents and composite documents can be selected for viewing by entering their
file names or using ‘drag and drop’ technique.

Document files can come from outside of the system or they can be acquired with an installed
scanner. TCDView cooperates with any scanner that is compatible with the TWAIN standard.

Scanned and vector documents displayed by TCDView can be printed on any device, printer
or plotter, which is controlled by an MS Windows graphics printer driver. TCDView can print to
standard MS Windows drivers, drivers provided by printer/plotter vendors or drivers developed
by Tessel Systems for selected raster devices.

TCDView can efficiently print documents of any size supported by given output device. The
printing process is always performed using full resolution data from scanned or vector document
file scaled to the demanded output size.

Windows and menus layout

The figure below shows the TCDView program window.
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The TCDView main window title bar contains not only application name but also the name of
the file with the active (current) composite document, i.e. the document displayed in the active
window (active window title bar is displayed in a different color). After the name of the current
document there is a list of the first three component drawings of this composite document in
brackets. Below there is the main menu bar with the program’s menus. Each of them is an
entry to a pull-down menu with a set of commands. An optional toolbar is displayed under the
main menu bar and contains icons, which allow access to the most frequently used commands.
Documents are displayed in the remaining place of the main window. A status bar, also optional,
is displayed under window(s) with documents. It shows the information supporting the user such
as messages, system Help information, selected information concerning the active document
and some keyboard status information.

Each of composite documents displayed by TCDView (an open document) has its own window
with scrollbars. In the caption bar of each document window, after the document name, there
is a list of the first three component drawings of this composite document (in brackets). The
layout of windows with documents can be changed automatically (with commands invoked from
the Window menu) or manually according to specific user’s needs. A document window can be
minimized to a TCDView icon labelled with the document name. Such a document is still present
on the list of open documents in the Window menu.

When none of documents is open, for example immediately after program start-up or after
closing all of document windows, the program main menu is in shortened form with only File,
View, Options and Help entries. Using them you can open document(s), configure system by
attaching printer, plotter or scanner, start acquiring document from a scanner and perform raster
files format conversion. You can also disable or enable the toolbar and status bar. The Help
command is always accessible.
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When the first document is opened, the main menu is extended with new commands, so
that all program functions are available. They are described in detail in the section “TCDView
commands”.

TCDView and Clipboard operations
The ability to transfer data between applications is one of the most important features of the
MS Windows system. It allows, for example, to place a document created by one application
inside a document in another application. Copy and Paste commands are used for transferring
data between applications. The Copy command puts information in an appropriate format to the
MS Windows Clipboard. The Paste command gets information from the Clipboard to another
application in one of the formats supported by that application.

A document can be copied to the Clipboard in one of the standard MS Windows document
formats:

• Device Dependent Bitmap

• Device Independent Bitmap

• MS Windows metafile

TCDView allows to control formats of data copied to the Clipboard. Relevant parameters in
TSLTCDVIEW.INI file, described in the section called “TSLTCDV.INI file”, are used for switching
on and off the copying of data in different formats. Moreover, it is also possible to control the
moment, in which data will be copied to the Clipboard. Document data can be copied immediately
after issuing the Copy command or only when the data is embedded to a document in client
application.
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TCDView commands

File menu commands

The File menu commands are used for selection of documents to be opened, for selection of
scanner and for starting the scanning, for document printing or conversion to different raster
formats, for closing the documents and for exiting the program.

This menu also shows up to four file names of documents that were most recently used.
Clicking on a name opens the selected document. Names of these files are stored in the
TSLTCDVIEW.INI file in the section [Recent File List].

New

The New command is used to create a new empty composite document. Drawings can be added
to such a document using the Add Subdoc command from the Document menu.

Open...

The Open command is used for selection of a composite document or a single drawing file, which
is to be opened by TCDView. In the dialog box, launched by the Open command, you should
select a needed file format type, disk drive and directory on this drive.



User Manual

6

As a result of these selections the program will display the list of all files in the selected directory
with the selected extension. Every change of the format type or of a disk and/or directory is
immediately reflected in the displayed list of files. Opening of a document file from that list is
done by its selection with the left mouse button click and then clicking the OK button; the left
mouse button double click on the file name on the list is an alternative method.

When you select raster or vector drawing file for opening, TCDView creates a new composite
document, which contains a single drawing just selected.

When the Shift or Control key is pressed, it is possible to select multiple file names. When
the Shift key is pressed, you select only the first and the last of files you want to open and all the
files between them on the list will also be selected. When the Control key is pressed, you select
multiple file names by clicking on each of them separately - they do not have to be neighbours
on the list. After selecting all desired file names, you click the OK button and all selected files
are opened - each in its own window.

The Open command can be always used, i.e. you can view more then one document at any
given moment. Documents are displayed in separate windows. Only one of them is active at
any given moment - its title bar is displayed in a different color - and all commands apply to this
document. To make another document window active, you simply click this window area. If it
is invisible, you select it from the list available in the Window menu. The Window menu is also
used for document windows ordering.

Close

The Close command is used to terminate displaying a document by closing the file with its
contents. When multiple documents are open simultaneously, the command refers only to the
active document. When in the course of the session the document has been modified, the user
is asked to decide whether to save the changes. If positive, the document will be saved in the
same file from which it has been loaded (opened).

If a composite document being closed was created by opening a single raster or vector drawing
and no viewport or parameter changes were made, then Close does not ask for saving this
document and, if it is to be saved, it must be done explicitly using the Save As... or Save
command. This facilitates the viewing of single raster and vector files without creating trivial
composite documents that refer to one file only.
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Save

The Save command is used for saving the changes to the current composite document in the
same file from which the document has been loaded (opened). The Save command is available
if the current document is a new document or if it has been modified using commands from the
Document menu.

Save as...

The Save as... command is used to save the current document in a file different from
which that document has been loaded. When several documents are loaded, the Save as...
command refers only to the active document. In the dialog box, invoked by this command, you
select a disk drive and a directory on this drive. Then enter, or select from the displayed list,
a file name with TCD extension. If the file with the entered name exists, the program launches
additional dialog box that asks you, if you want to overwrite the existing file.

Convert...

The Convert... command is used to create a new version of a drawing in a raster format
different than the original. This command launches the dialog box named Input File, otherwise
identical to the dialog box in the Open command and serving the similar purpose of the drawing
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file selection. The selected file in this case will not be displayed but only read in order to be
converted. After the input file is selected, the analogical dialog box Output File appears. It allows
to select a new drawing format, file name and destination (disk drive and directory). If the newly
selected file format supports multiple compression modes, an additional dialog box appears for
precise selection of a desired file subformat.

The list of output file formats and compression modes depends on the format of the converted
(input) file. The full list of formats that are available in each case is displayed in the File Type
list box.

When multiple input files are selected, they are converted to a single file in one of multi-page
formats (TIFF, DCX). Each page in the resulting document contains data from the corresponding
input file. You can suppress this feature and convert each input file to a separate destination
file by setting the ConvertToOneFile parameter in the TSLTCDVIEW.INI file to 0 (see the
section called “TSLTCDV.INI file”).

Print

The Print command starts printing selected document or launches the Print dialog box that is
based on which printer was chosen in Print Setup dialog (see below). So before printing please
first open Print Setup dialog

Print Preview

The Print Preview command launches Page Preview window. This is the window showing
what will be printed - it allows setting the layout of the printed document view on the displayed
paper sheet.
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Print Window

Print Window command starts launches resizeable box on current document that can be used
to control the printing scale and area of picture to be printed.

You can grab each corner of the box using Left Mouse Button and drag it to set the area
for printing.
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When you have set area for printing, click Right Mouse Button to open context menu:

• Accept command cuts the picture to the selected area and enables new commands from
context menu.

1. If you have focus on hole printing page (by default after clicking Accept command) then in
context menu you will have:
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• Print Window - goes back to Print Window where you can again choose area for
printing,

• Print Setup - opens Print Setup dialog (see below for more information on this dialog),

• Page Setup - opens Margins dialog where margins can be set,

• Portait/Landscape - changes the picture orientation.

• Print - starts Printing based on the chosen printing configuration selected in Print Setup
dialog,

• Publish HTML - creates simple HTML page with the image for print linked to it.



User Manual

12

• Exit Preview - goes back to standard TCDView screen.

2. If you have focus on the area selected for printing, (it can be easily distinguish by red squares
on each of the area corners) than this context menu will show:

• Cancel - goes back to Print Preview look,

• Various scales values that can be chosen for the printing area,

• Select... - opens a dialog where you can set your onw scale.

Print Setup

The Print Setup... command launches the Print Setup dialog box.
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In this dialog box it is possible to:

• select the current print device from the list of available devices,

• change some printer parameters (e.g. print orientation, paper size, paper source),

• set print quality parameters in the Properties dialog box, which is displayed after pressing the
Properties... button.

New printer drivers can be added and printer to port mappings can be changed using the MS
Windows system Control Panel.

Scan

The Scan command is used to start scanning of a new document. Depending on the kind of
scanned document (single-page or multiple-page) one of two options can be selected:

• One page,

• Multiple pages.

Before scanning it is necessary to select a file name and a raster format of the drawing that
will be created as a result of scanning. After scanning, a new composite document is created,
containing a single raster file with the scanned image.

One page

This command starts scanning of a single-page document.

Depending on the type of the selected scanner it may be necessary to start scanning physically,
e.g. by pressing a button on the scanner. Some scanners can start scanning automatically, others
can display their proprietary window with information about scanning progress. The scanned
document is then displayed in a window labelled with a temporary name, e.g. SCAN_1.

Multiple pages

This command starts scanning of a multiple-page document.

The process of multiple-page scanning is similar to the single-page scanning. After each page
the dialog box appears and informs about the number of pages scanned so far. Four buttons are
available (some of them can be disabled, depending on the situation):

• Next - confirms the last scanned page and starts scanning of the next one;
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• The Same - repeats scanning of the last page;

• Close - confirms the last scanned page and stops scanning; the file will contain the number
of pages as currently displayed in the dialog box;

• Cancel - stops scanning and discards pages scanned so far.

The first page of the scanned document is displayed in a window labelled with a temporary name,
e.g. SCAN_1.

Select Source

The Select Source command is used for selection of the current scanning device. The Select
Source command is relevant only when more then one scanner is installed.

Click a name and press the Select button to choose a scanning device. Particular scanning
parameters can be set using the Scan Parameters command from the Options menu. The
list shows only TWAIN-compatible devices that have been properly installed. When the part
of scanning software that is responsible for cooperation with applications that use the TWAIN
standard is present, the device should appear on the list of available scanners (no additional
installation on the part of TCDView is required).

Exit

The Exit command closes the TCDView application. If the user has made any changes to a
document(s), he can choose to save or cancel the changes using buttons of the dialog box that
appears automatically.

Edit menu commands

Copy View

The Copy View command is used to transfer the current view of the current document to the
MS Windows system Clipboard. Only the currently visible part of the document is transferred in
its current scale. Independently of the values of CopyEmbedded and CopyLink variables in the
TSLTCDVIEW.INI file, the Copy View command does not allow to embed or link data from the
Clipboard to other applications. The copy of the document view can be prepared only in DDB
bitmap, DIB bitmap and metafile formats.

Copy All

The Copy All command is used to send a copy of the current document to the MS Windows
system Clipboard. Basically it is used for simple interchange of documents between different MS
Windows applications.
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The Copy All command, unlike the Copy View command, prepares data from the whole
document, no matter what the current view is. It is also possible to define sizes and resolution for
preparing a copy of the document. Four variables are used for this purpose, Width, Height, Xres
and Yres, all with the ClipboardCopy prefix defined in the TSLRVC Library Settings section of
the TSLTCDVIEW.INI file. All these parameters can be changed by editing this file. New values
are used next time the program is run.

The default settings of variables result in making a copy of a document that is 6.67 inches
wide and 5 inches high with 96 dots per inch resolution. These parameters reflect the size and
resolution of a typical monitor screen. A document will be scaled in such a way that it will cover
the demanded area as fully as possible. A document can be copied in every available format
(embedded object, link, bitmaps and metafile).

When multiple documents are displayed, the command acts only on the current document.

Copy Special

The Copy Special command is used for sending a copy of the current document to the MS
Windows system Clipboard. Basically it is used for an interchange other than simple interchange
of documents between different MS Windows applications (see Copy All). The command
also copies the whole document, no matter what the current view is, but it uses parameters
defining sizes and resolution of the document copy, different than the Copy All command.
These parameters are read from four variables, Width, Height, Xres and Yres, all with the
ClipboardCopySpec prefix defined in the TSLRVC Library Settings section of TSLTCDVIEW.INI
file. All these parameters can be changed by editing this file. New values are used next time
the program is run.

The default parameter values are prepared for 1:1 copying of documents in a typical fax format,
i.e. 8 inches wide, 11 inches high, 96 dots per inch of vertical resolution and 203 dots per inch
of horizontal resolution.

If the current document is greater than the demanded copy size, then it is scaled, so that it
fills the requested copy size as fully as possible. A document can be copied in every available
format (embedded object, link, bitmaps and metafile). When multiple documents are displayed,
the command acts only on the current document.

Copy Special To...

The Copy Special To... command is used to make a copy of a document and save it to a
selected file. The width, height and resolution of created file are defined by the same parameters
as in the Copy Special command.
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The default parameters are set for copying to the A4-size page with a resolution typical for
fax devices. These parameters are read from four variables, Width, Height, Xres and Yres,
all with the ClipboardCopySpec prefix defined in the TSLRVC Library Settings section of the
TSLTCDVIEW.INI file. All these parameters can be changed by editing this file. New values are
used next time the program is run.

Saving a document in a new file can be combined with changing of the raster format and
compression mode (see the Convert... command from the File menu).

When multiple documents are displayed, the command acts only on the current document.

(CTXTDEF:HIDD_SUBFORMAT)In the dialog box invoked by the Copy Special To...
command you select a raster format type, a disk drive and a directory on this drive. Next, you enter
a file name with an extension that is appropriate for the selected raster format type. You may type
it or select it from the displayed list of files with previously chosen extension. If another file with the
same name exists, the program asks you, if you want to overwrite the existing file. If the selected
output file type supports multiple compression modes, you can choose a compression mode in
an additional dialog box Compression Mode for Output Document, which opens automatically.
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Document menu commands

The Document menu commands are used for composite document management. Using these
commands it is possible to add and delete drawings to/from composite document, to change the
order in which they overlap one another, to change properties of individual drawings belonging
to the composite document (like their position, current page or visibility status) and to change
parameters of the composite document as a whole (e.g. its presentation units).

For each component drawing its visible area, called viewport, is defined. Initially (after adding the
drawing to the document) it is set to full drawing extents. Viewport areas can be changed after
entering the Selecting mode using the Selecting command from the Document menu (also
available on toolbar). The Reset Viewport command sets the viewports of currently selected
documents to their initial size (full extents of each respective drawing).

Entering the Selecting mode is also necessary when one of: Enable, Disable, Change
Link..., Copy..., Order, Move, Properties..., Undo, Redo commands from the
Document menu is to be issued, because each of these commands operates on currently
selected drawings (Change Link..., Copy..., Properties..., Undo, Redo are active only
when exactly one drawing is selected).

Regenerate

TCDView is performance-optimized for viewing large raster and vector documents. For each
open document it keeps a full view of this document. This feature allows to execute the
Zoom-Extents command very fast. In some situations, however, the use of full view cache
can somewhat decrease the quality of document display. In this case the user can issue the
Regenerate command which forces full resolution redraw without using the stored view. Storing
and using of full view cache can be disabled by setting the UseFullViewCache parameter in
the TSLTCDVIEW.INI file to 0 (see TSL_0050_Appendices_0020_SUPEREDINI-file).
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Add Subdocument

The Add Subdocument command from the Document menu is used to add a new component
drawing to the current composite document. It launches a dialog box for selection of a drawing
to be added.

Remove Subdoccument

The Remove Subdoccument command from the Document menu removes currently selected
drawings (see the Selecting command) from the current composite document. Of course, it does
not delete the drawing’s file.

Views Manager

Select / Edit Viewports
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Properties...

The Properties... command launches the Composite Document dialog box. This dialog box
groups together most of commands available in the Document menu (described in following
sections). In addition to buttons for issuing these commands, the Composite Document dialog
box displays a list of component drawings in the current composite document. Using this list it is
easy to select drawings as arguments to commands that operate on specified drawings.

The Composite Document dialog box lists the component drawings in four columns. The first, the
second and the third column show the drawing status information, and the fourth one displays
drawing file names. The first column contains plus sign (+), if the corresponding drawing is
enabled (visible) or minus sign (-), if the drawing is disabled (invisible). The second column can
be empty or it can contain either the “N/A” text, if the drawing’s file can not be found, or the “R/
O” text, if the drawing is open in the read-only mode. The third column contains “S” character,
if the corresponding drawing is selected.

If the Properties... command is issued in the selecting state (see description of the Selecting
command), currently selected drawings will be shown as selected in the dialog box list. After
closing the Composite Document dialog box in the selecting state, drawings which were selected
in the dialog box list remain selected and the other drawings are not selected. This way it is
possible to perform drawing selection from the list of component drawings. This selection method
is alternative to the mouse click selection method described in the Selecting command section
below.

Enable

The Enable command from the Document menu turns the currently selected drawings visible.
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Disable

The Disable command from the Document menu turns the currently selected drawings invisible.

Order

The Order command from the Document menu allows to control the order in which component
drawings overlap one another, when the composite document is displayed or printed. The Order
command has four subcommands described below. Each of them moves selected drawings on
the composite document’s drawing list.

Bring to front

The Bring to front command moves selected drawings to the front end of the composite
document’s drawing list, i.e. makes them cover the other drawings.

Send to back

The Send to back command moves selected drawings to the back end of composite
document’s drawing list, i.e. puts them under the other drawings.

Bring forward

The Bring forward command moves selected drawings (see the Selecting command) one
step in the front direction on the composite document’s drawing list, i.e. makes them cover the
drawing which preceded them immediately on the composite document’s drawing list. Issuing
the Bring forward command sufficient number of times is equivalent to issuing the Bring to
front command one time.

Send backward

The Send backward command moves selected drawings one step in the back direction on
the composite document’s drawing list, i.e. puts them under the drawing which followed them
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immediately on composite document drawing’s list. Issuing the Send backward command
sufficient number of times is equivalent to issuing the Send to back command one time.

Move

The Move command from the Document menu allows to change the position of the selected
drawing in the composite document world coordinate system. After selecting one drawing and
issuing the Move command, click the point (within the selected drawing) to be moved and then
click at the place that you want the first point to be moved to. The viewport (i.e. visible area)
of the drawing being moved is moved with it as well. This way the same area of the drawing
remains visible.

Reset Viewport

The Reset Viewport command from the Document menu resets the viewports of currently
selected documents to their initial sizes (full extents of each respective drawing).

Params...

The Params... command from the Document menu is active only when exactly one drawing is
selected. This command launches the Raster Drawing Parameters dialog box (or Vector Drawing
Parameters, depending on the current drawing type), which allows to edit technical parameters
of the selected drawing.
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The Raster Drawing Parameters dialog box is a tabbed dialog. It can have from one up to three
pages. The page titled Parameters is always present. The page titled Pages is present only when
properties of multipage raster drawing are shown. The page titled Colors is present only when
at least one drawing page is monochrome. On the Parameters page you can set the following:

• Effective Drawing Extents - values calculated from the other parameters;

• Scale - it is possible to set the nominal scale of the document;

• Resolution X x Y - it is possible to set the nominal horizontal and vertical resolutions of
the bitmap in dots per inch;

• Insertion Pointio - it is possible to enter the insertion point coordinates, i.e. world
coordinates of the bottom left corner of the drawing;

• Unitsu - list box allowing to select units for the insertion point;

• Change orientation - it is possible to rotate the view of the drawing left, right, by 180
degrees or perform vertical or horizontal mirroring of the view;

• Colorc - pressing this button launches the Raster Color dialog box; color can be defined only
for monochromatic raster drawings;

• Drawing Description - it is possible to add textual document description.

On the Pages page you can select the current page of multipage raster drawing.

On the Colors page you can select color of monochrome raster drawing.

Vector Drawing Parameters dialog box is a tabbed dialog. It has two pages: Parameters and
Layers. On the Parameters page you can set the following parameters:

• Units- list box allowing to select units for the vector drawing;

• Change orientation - it is possible to rotate the view of specified drawing left, right, by
180 degrees or perform vertical or horizontal mirroring of the view;

On the Layers page it is possible to enable or disable displaying of particular layer of the vector
drawing.

In the Change Orientation group of both drawing parameter dialogs there are icons with arrows
describing available orientation changes. To make orientation changes even simpler there is also
an icon with the P character. After entering the Drawing Parameters dialog box this icon shows
the P character in normal orientation. After pressing any of buttons with arrows, the P character
rotates accordingly, thus showing how drawing will be rotated when the OK button is pressed.

The values of drawing parameters are saved in the drawing file, if the drawing format allows
for it, and in an additional parameter file with the same name as drawing file name but
with TAF extension. The additional file is located in the same disk directory as the drawing
file. The additional parameter file is necessary, because not every parameter can be saved
in the original drawing file. Some drawing file formats allow to store more parameters than
other formats. Parameters saved in the original drawing file override parameters saved in its
additional parameter file. Creation and reading of parameter files can be controlled using the
BRAOpenOptions parameter in the TSLTCDVIEW.INI file.
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The parameter values are read from the drawing file and possibly from its parameter file. All of
them can be changed, except for Drawing Extents that are calculated from other parameters.
When any parameter has been changed, the drawing is considered changed, and TCDView asks
the user for saving changes in a file, when it is about to be closed.

Zoom menu commands

The Zoom menu commands are used for displaying selected fragments of documents and for
magnifying or lessening the current view.

For each open document TCDView keeps a full view of this document. This feature allows to
execute the Zoom - Extents command very fast. Full view cache is also used for other zooms,
unless it decreases view quality too much. The Regenerate command forces the full resolution
redraw without using the intermediate stored view. Storing and using of the full view cache can
be disabled by setting the UseFullViewCache parameter in the TSLTCDVIEW.INI file.

Pan

The Pan command allows to move around the opened document.

Window

The Window command allows to define any rectangular view of a document. After defining a
rectangle, the raster area inside it is redisplayed according to a new scale, such that the selected
area fills up the whole current document window. View expansions in one direction, if necessary,
are added automatically. The Zoom-Window command is the default action when the user selects
a rectangle in a document window, so it is not necessary to invoke this command directly to
execute it - selecting a rectangle to be viewed with the mouse is enough.

Previous

The Previous command displays the previously defined view of the current document (if such
a view exists). The maximal number of remembered views is 15.

In

The In command magnifies the current view (approximately two times) relatively to its center
point. The view will present a smaller document area but will contain more details.
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Out

The Out command increases the area covered by the current view (approximately two times)
relatively to its center point. The view will present a larger document area but will contain less
details.

Extents

The Extents command is used to display the view of the whole current document (by magnifying
or lessening its view), so that it fills up possibly largest part of its full window.

Scale 1:1

The Scale 1:1 command is used to view a single drawing document on the screen in its original
physical dimensions. When the current composite document contains more than one drawing,
this command is not available.

In this command the vector or raster data is displayed on the screen in such a way, that one inch
on the screen is equivalent to one inch on the paper document original (with maximal possible
accuracy).

Adaptive Zoom

Adaptive Zoom option is by default ON

View menu commands

The View menu contains commands to activate and deactivate Toolbar and Status Bar.

Main Toolbar

The Main Toolbar command toggles the display status (visible/invisible) of the main toolbar,
which is on the top of the main TCDView window, just below the main menu bar.

If this option is switched on - what is indicated by the presence of a marker before the command
name in the View menu - then the toolbar is displayed and through icons displayed on itself
allows for fast access to the most frequently used TCDView commands. The verbal description
of commands available through the toolbar is displayed on the status bar, when the left mouse
button is press and held with the cursor over a toolbar icon. Switching the Toolbar option off by
clicking on its name in the View menu results in disappearing of the toolbar. The next click on
the option name switches the option and the toolbar on.

Raster Pages toolbar

This command toggles the display status (visible/invisible) of Raster Toolbar which is just next
to Main Toolbar.
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Status Bar

The Status Bar command toggles the display state (visible/invisible) of the status bar (see
the Windows and menus layout section), which is located at the bottom of the main TCDView
window.

If this option is switched on - what is indicated by the presence of a marker before the command
name in the View menu - then the status bar is displayed, presenting in its left part the verbal
description of the command currently being selected from the application menu or from the
toolbar. Library procedures also display its messages on the status bar - mostly with percentages
of progress of their complex operations. The Measure Distance command from the Options
menu displays its results on the left side of the status bar.

There are three information windows on the right side of the status bar. They are used to display
(from left to right):

• the first window is filled only in selecting state - when one component drawing is selected, its
name is displayed, when two or more drawings are selected, their number is displayed (e.g.:
“Sel: 2 of 4”);

• current coordinates of the mouse cursor in the world coordinate system of the composite
document displayed in the current window;

• presentation units of the document displayed in the current window; mouse cursor coordinates
are expressed in these units.

Switching the Status Bar option off by clicking on its name in the View menu results in
disappearing of the status bar. The next click on the option name switches the option and the
status bar on.

Options menu commands

The Options menu commands can be used to set some parameters of the current scanner and
to measure distance (in the real world units) between points of the current document.

Configuration

The Configuration command opens TCDView Configuration dialog where you can configure
TCDView program. The dialog consists of 5 tabs:

Open, Save, Magnifying Glass, View, Print.
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Open tab

The Open tab allows you to configure options that control opening TCDView files:

• Select single file documents

If this option is checked TCDView automatically selects a single image file, or a TCD file with
only one subdocument, immediately after the open operation. This option corresponds to the
AutoSelectSingleFile parameter from the [TSLRVC Library Settings] section in the
TSLTCDVIEW.INI file.

• Zoom default document view

If this option is checked, immediately after opening a raster image or a composite document
TCDView uses default view parameters.

The Parameters file options… button invokes the External Parameters File Options dialog
that lets you set options and priority of particular file formats. The parameter values are read
from the image file and possibly from its attribute file. All of them can be changed, except for
the Effective Image Extents that are calculated from other parameters. When any parameter
has been changed, the image is considered as changed, and TCDView asks the user for saving
changes in a file, when it is about to be closed.
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You can specify the following options for each parameter file format:

• Enable to Read

if selected TCDView tries to find parameters file corresponding to currently opened image and
read missing parameters,

• Enable to Write

if selected TCDView tries to find parameters file corresponding to currently saved image and
write new parameters values,

• Create file if not exists

Create file if not exists – Accessible only when Enable to write is selected. Controls whether
a file in this format should be created if it does not exist.

Additionally you can define parameter file priority by sorting them in the list.
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Save tab

The Save tab allows you to defining the following options:

• Copy subdocs while Saving As... TCD file

If this option is checked TCDView saves not only TCD file with links to raster images or
vector drawings, but also copy all subdocuments to new files. This option corresponds to
the TCDSaveMode parameter from the [TSLRVC Library Settings] section in the
TSLTCDVIEW.INI file.

• Convert to one file

If option is selected TCDView creates the multi-page destination file while converting multiple
input files.

Preferred save file extension

Some raster formats may be saved under different file extensions. These include Tiff, Vidar,
CALS and Bitmap. You can define preferred extension for each format.
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Magnifying Glass tab

The Magnifying Glass tab allows you to configure the Magnifying Glass tool. Checking Magnifying
Glass active box activates the function. When the Magnifying Glass window is displayed, you
see a zoomed raster area around the position of the mouse pointer (the AutoCAD’s cross-hair)
at the moment of the Magnifying Glass activation. If raster snap was active and successful, its
result will be indicated by a cross symbol. If the snap result is not satisfactory, you may pick a
new point precisely. The Keep on display option controls the method of closing the Magnifying
Glass window. If option is not selected the Magnifying Glass window is closed automatically if you
move the mouse cursor outside the window or you pick a new point inside the window. Otherwise
the Magnifying Glass window disappears after pressing the Esc key or right mouse click. The
Esc key cancels the point in the Magnifying Glass window.
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View tab

The View tab allows you to define view options:

• Use dithered colors

If this option is checked TCDView uses dithering to improve image colors mapping. The option
is especially useful when displaying images with a lot of colors on display devices with only
16 or 256 physical colors. This option corresponds to the DitherMode parameter from the
[TSLRVC Library Settings] section in the TSLTCDVIEW.INI file.

• Enable image transparency

This option is responsible for switching on or off the usage of transparency information defined
in a raster image.

The View cache options or Print cache options buttons invoke configuration dialogs of TCDView’s
integrated view and print cache. All modified parameters are stored in the TSLTCDVIEW.INI file.
More information about modified property is specified in appendix.
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Print tab

Scan Parameters...

The Scan Parameters... command launches a dialog box which allows to set technical
parameters of the scanning process. This dialog box depends on the current scanner type and
is displayed and managed by its driver. The parameters are specific for the particular type of the
scanner that is currently used. After setting parameter values one must initialize the scanning
process.

Note

Saving the parameter values is done during scanning. That is why in order to save
parameters, one must perform “dummy” scanning - it is not enough just to set parameters
up.

Measure distance and azimuth

The Measure and azimuth distance command expects you to click the mouse left button at
two points of the current document area. It then displays the real world (not paper document)
distance between these points and angle of created line against the p on center of the status bar.
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Window menu commands

The purpose of the Window menu commands is to change the layout of open document windows.
The third part of this menu displays a list of open document names. These names are equivalent
to document window names, which allows to select a new current (active) window. This is
necessary, since the required window may be completely covered by other windows. The current
window is marked in the menu with a check marker.

New Window

The New Window command opens a new window with the current document. The next ordinal
number of the window (opened with the same composite document as the previous current
window) is displayed on the title bar of this window to the right of the file name(s).
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Tile Horizontally

When more than one document window is open, the Tile Horizontally command divides
the whole TCDView main window between all equally sized document windows. When just one
document is open, its window is expanded to fill the entire TCDView main window.

As a result of this command, open document windows are arranged in such a way, that each is
visible and does not overlap with any of the other windows and the neighbouring windows have
common horizontal borders.

Tile Vertically

When more than one document window is open, the Tile Vertically command divides
the whole TCDView main window between all equally sized document windows. When just one
document is open, its window is expanded to fill the entire TCDView main window.

As a result of this command, open document windows are arranged in such a way, that each is
visible and does not overlap with any of the other windows and the neighbouring windows have
common vertical borders.

Cascade

When more than one document window is open, the Cascade command arranges open
document windows on the main TCDView window in such a way, that they overlap and form a
kind of stack but each is shifted a little, so that their title bars are visible. The current document
window remains active and is put on the top of the stack of document windows.

When just one document is open, its window is expanded to fill the entire TCDView main window.
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Arrange Icons

Every document window can be minimized to a form of a TCDView icon labelled with a document
name. The names of minimized windows (documents) remain present on the list of open
documents in the Window menu. These icons can be dragged with the mouse one by one to a
new place. The Arrange Icons command changes the placement of this icons. It puts them
in a row(s) at the bottom of the main TCDView window. When you double click with a mouse
on a document icon or click on a document name on the list in the Window menu, the selected
document window opens again at the previous place and size. The Arrange Icons command
does not move open windows, so they may overlap the area, where document icons are placed.
In such a situation you can uncover the icons by resizing the windows manually or with the
Cascade command.

Close All

The Close All command closes all open document windows and is particularly useful when
many documents are simultaneously open in one session.

Help menu commands

Contents

Manual command opens a CHM file containing TCDView manual.
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About

The About TCDView... command displays the TCDView serial number and copyright
information.
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Chapter 2. Administration
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Installation

Requirements
In order to use TCDView you should have:

• Microsoft Windows 8, 7 or Vista Operating System,

• at least 20 MB of free hard disk space,

• mouse or other pointing device supported by MS Windows,

• graphics card and monitor of at least VGA capabilities,

• RAM as recommended to run Operating System.

Program installation and running

Installation process

TCDView Setup provides a quick and easy way to install this program on a user computer or file
server. Setup uses a standard Windows user interface style. It contains all features and functions
that are appropriate for Windows applications.

After loading CD-ROM, Tessel Software Line Setup starts automatically and lets you choose
a product and its language version. In order to restart Tessel Software Line Setup, e.g.
to install more products, re-load CD-ROM or open it in Windows Explorer and double-click
TSLStartup.exe.

During setup, you can accept or choose an installation directory for TCDView.

The default directory name is C:\Program Files\Tessel Software Line\TCDView (if selected
directory does not exist, it will be created, even with its parent directories).

After this phase Setup starts copying selected files to the installation directory. During this, Setup
displays its progress bar.

Setup copies all TCDView files to the chosen directory and creates the log of performed
operations. Demo files are copied to the additional DOC subdirectory that may be deleted when
no longer needed. The newly created program group Tessel Software Line contains the following
items:

1. TCDView to launch the program

2. Read Me to show the technical notes in Notepad

3. Help.

The default TCDView INI file (tsltcdv.ini or tsltcdv64.ini) is copied to the hidden Window's
directory: C:\Users\<username>\AppData\Roaming\Tessel Systems\. It contains the
option settings and the default attribute values for TCDView commands.

Some problems can occur under Windows when user without assigned administrator privileges
invokes Setup. In addition Windows UAC (User Account Control) may interrupt installation. In
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such situation please turn off UAC (Vista) or change its state to lowest position (Windows 8 and
7).

Important

When finished, Setup will ask if you want to launch TCDView after closing Setup.

Please do not use this option and launch TCDView manually afterwards.

Running TCDView

TCDView consists of the main program file TSLTCDVIEW.EXE and several auxiliary libraries.

After proper installation TCDView can be run by clicking on the TCDView icon in the Tessel
Software Line window or from command line (cmd.exe program). While running TCDView from
a command line you can supply a list of full path names of document files as parameters. For
example, the command line can read as follows:

C:\Program Files\Tessel Software Line\TCDView\TSLTCDVIEW.EXE
C:\Program Files\Tessel Software Line\TCDView\DOC
\GOTEBORG.TCD   PHONE.PCX

where C:\Program Files\Tessel Software Line\TCDView\ is the directory, in
which TCDView has been installed, C:\Program Files\Tessel Software Line
\DOC\ is the directory containing document and document files, GOTEBORG.TCD is the file
name of a composite document and PHONE.PCX is the file name of a picture, which are
to be loaded at start-up. When the program starts, it will open each composite document
file in a separate document window. The CmdLineParsMode parameter in the TCDView
Settings section in the TSLTCDVIEW.INI file allows you to control how TCDView opens
simple document files in raster or vector format supplied on the command line list (). By
default (CmdLineParsMode=0) TCDView opens simple document files in a separate document
windows. If you set CmdLineParsMode parameter to 1 than all simple document files are opened
in a single document window.

Removing TCDView program

Setup includes an integrated uninstallation program that allows users to uninstall TCDView
components cleanly and effectively and recover system resources such as disk space used by
files and registry entries.

If, for some reason, you must uninstall TCDView, run the Uninstall program icon or start
Control Panel’s Programs and Features, select TCDView and click the Uninstall button. Uninstall
will remove most of the TCDView program files and delete changes made to your Windows
files. However, some files that are used by Windows or other programs may not be removed
automatically, so it may be necessary to delete them manually.
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TSLTCDV.INI file
The tsltcdv.ini text file is copied to the Window's hidden directory: C:\Users\<username>
\AppData\Roaming\Tessel Systems\ directory during the installation. It is used to store
various TCDView control parameters. Some of them may be changed by TCDView commands,
others can be changed only by editing the file.

File line syntax: <Parameter_name>=<value>

Comment line syntax: [<comment>]

Binary values of some parameters are coded as 0 or 1, which means switched off or on
respectively.

The list of parameters in the tsltcdv.ini file are listed below:

[External Parameters Filters] section
Definitions of four attribute file type extensions and their support:

• 1=TAF, 7

• 2=RLD, 3

• 3=MapInfo, 2

• 4=ARCINFO, 6

Meaning of numerical attributes:

• 1 – read, do not save, do not create if not exists

• 2 – do not read, save, do not create if not exists

• 3 - read, save, do not create if not exists

• 4 – do not read, do not save, create if not exists

• 5 – read, do not save, create if not exists

• 6 – do not read, save, create if not exists

• 7- read, save, create if not exists

Priority
Defines priority of attribute files.

Example:

Priority=1 2 3 4

[Geographical Mappings] section

AutoLoad
Load geographical mapping defined in TAF file when opening document. Possible values
are:
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• 0 - opition is off

• 1 - option is on

Example:

AutoLoad=1

Mapping
Mapping up to four lines, where i = 1..4, defining names of up to four geographical mapping
systems recently used. The mapping name consists of system dependent texts and numbers
but always starts with generic geographical system mapping name (see Geographical
Mapping dialog).

Example:

Mapping1=P42 21 6

MappingActive
Make last used geographical mapping active when application is started.

Example:

MappingActive=1

[Licensing] section
FLEXLicenseFile=C:\Program Files\Tessel Software Line\HyperDoc\Program
\license.dat

This section is sometimes needed when LMTOOLS was installed before by other application
and when Windows environment variable "LM_LICENSE_FILE" points to other Licence.dat file
than Products's licence file.

Important

This parameter refers only to old licensing system based on .dat files. New .xml licences
does not have their section/parameter and are needed to be in Program main folder.

[Raster Image Params] section

Color
Default value of color number in the drawing palette (for monochrome raster images only).
Used when raster image has not corresponding TAF file.

Comment
Default value of image’s description or a remark text. Used when raster image has not
corresponding TAF file.

Length
Default value of number of pixels in a single raster line. Used when raster image has not
corresponding TAF file.
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Orientation
Default value of image’s orientation. Defined in raster terms (lines and columns of pixels)
but maintaining analogous meaning also for vector drawings. The Orientation can have one
of the following values:

• 1 - first line at the top, first column at the left side

• 2 - first line at the top, first column at the right side

• 3 - first line at the bottom, first column at the right side

• 4 - first line at the bottom, first column at the left side

• 5 - first line at the left side, first column at the top

• 6 - first line at the right side, first column at the top

• 7 - first line at the right side, first column at the bottom

• 8 - first line at the left side, first column at the bottom

Used when raster image has not corresponding TAF file.

Units
Default value of code number of units used to define the insertion point of the image; one
of the following values:

• 1 - inch

• 2 - foot

• 3 - yard

• 4 - mile

• 5 - millimeter

• 6 - centimeter

• 7 - meter

• 8 - kilometer

Width
Default value of number of raster lines. Used when raster image has not corresponding TAF
file.

XinsertionPoint
Default value of X coordinate of the lower left corner of the image. Used when raster image
has not corresponding TAF file.

Xresolution
Default value of image’s horizontal resolution. Used when raster image has not
corresponding TAF file.
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Xscale
Default value of horizontal scale of the image. Used when raster image has not
corresponding TAF file.

YinsertionPoint
Default value of Y coordinate of the lower left corner of the image. Used when raster image
has not corresponding TAF file.

Yresolution
Default value of image’s vertical resolution. Used when raster image has not corresponding
TAF file.

Yscale
Default value of vertical scale of the image. Used when raster image has not corresponding
TAF file.

[Raster Magnify Glass Options] section

HotKey
Defines hotkey, that popup raster magnifying glass.

Examples:

HotKey=32 ; Space key

HotKey=196608 ; CTRL + Shift

KeepPopup
If set to 1, magnifying glass window is keeping opened until you press Esc key. If set to 0,
magnifying glass is closed on mouse move.

Magnification
Defines magnifying glass magnification parameter. Possible values are integer numbers
between 2 and 10.

Example:

Magnification=10

MagnifyGlassActive
If set to 1, raster magnifying glass is active.

Example:

MagnifyGlassActive=1

MagnifyGlassSize
Defines magnifying glass window size in pixels. Possible values are integer numbers
between 50 and 250.
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Example:

MagnifyGlassSize=200

PopupOnHotKey
If set to 1, raster magnifying glass is popup after hotkey pressing. If set to 0, you can't use
magnifying glass on pop-up key.

Example:

PopupOnHotKey=1

[Raster Snap Options] section

CurvePar
Integer value; specifies curvature parameter for tracing lines.

Pickbox
Decimal value; specifies the size of snap pickbox (in pixels).

SegmentPar
Integer value; specifies minimal segment length (in raster pixels) for tracing lines.

SnapActive
Binary value; specifies whether snap to raster is active.

SnapMode
Specifies snap mode value. Use the Snap tab on Configuration dialog to change it.

TraceWidth
Decimal value; specifies user-defined width to be used while tracing lines.

UseTraceWidths
Binary value; specifies whether to use detected raster line widths while tracing lines.

[Recent File List] section

The entries in this section specify the names of 4 documents most recently opened by TCDView.

[TCDView Settings] section

CmdLineParsMode
binary value; this parameter controls how TCDView opens simple document files (in raster
or vector format) supplied on the command line list:

0 - each simple document file is opened in separate document window (TCDView default);
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1 - all simple document files from command line are opened in single document window;

[TSLCDC Cache Settings] section

Enable
Binary value; default 1, setting it to 0 disables use of the view cache.

FullViewHeight
Height of the full view bitmap in pixels; when set to 0 SuperEdit calculates full view size
according to your display resolution.

FullViewWidth
Width of the full view bitmap in pixels; when set to 0 SuperEdit calculates full view size
according to your display resolution.

MinimalRegenKeepTime
Specifies limits for view kept in cache. Only document with greater regeneration time than
specified will be stored in cache. Value in milliseconds, default is 250 ms.

MinimalRegenSaveTime
Specifies limits for cached view to be stored in TCD file. Only document with greater
regeneration time than specified will be written to TCD document.

SaveFullView
Binary value; default 1; setting it to 0 disables saving of the full view cache.

ZoomQuality
Decimal value in range 5 to 100, default is 75. Determines when cached views may be used
instead of regeneration. Lower value means weaker image precision requirements, greater
- requires more quality, but also causes more regenerations.

[TSL Diagnostics] section

AddTimeStr
Defines if time stamps are present in diagnostic log. Possible values are 0 or 1. If is set to
0, time stamps are not logged.

Example:

AddTimeStr=1

FlushLog
Defines if diagnostic log is flushed before writing new data. Possible values are 0 or 1. If is
set to 1, the buffer is flushed with every log entry writing.

Example:

FlushLog=1
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LogBasic
Defines if diagnostic log should contain basic log data. Possible values are 0 or 1. If is set
to 1, all performed actions are logged.

Example:

LogBasic=1

LogLDAP
Defines if diagnostic log should contain LDAP data. Possible values are 0 or 1. If is set to 1
and LDAP login mode is enabled, diagnostics informations are logged.

Example:

LogLDAP=1

LogName
Full path to log file.

Example:

LogName=C:\Program Files\Tessel Software Line\HyperDoc\DemoDB
\Netman.log

TraceErrors
Defines if diagnostic log should contain error messages. Possible values are 0 or 1. If is set
to 1, occurred errors are logged.

Example:

TraceErrors=1

[TSLPPL Library Settings] section
For internal use only. Parameters for library TSLPPL (print cache options).

BufferSize
The size (in kilobytes) of the internal SuperEdit cache buffer used for printing of color
documents (except for 24-bits-per-pixel color documents).

BufferSize24
The size (in kilobytes) of the internal SuperEdit cache buffer used for printing of 24-bits-per-
pixel color documents.

FitToPage
Binary value; causes such calculation of the print scale, that the document covers maximal
area of the paper page.

MetricUnits
Binary value; when set to 1, the print margins and origin are expressed in millimeters,
otherwise in inches.
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PrintColors
Binary value; enables color printing.

PrintingScale
Real number representing the printing scale.

Selection
Binary value; when set to 1, the whole document is printed, otherwise its current view only.

SmallBitmaps
Binary value used to correct errors in some printer drivers. When set to 1, the SuperEdit
send data to printer driver in portions smaller than 64 Kbytes. When set to 0 may speed
printing operation.

XOffset
Horizontal distance between the upper left corner of the document area on the paper and
the upper left corner of the page margins; if negative, then a part of the document is placed
within the left margin area and is not printed.

YOffset
Vertical distance between the upper left corner of the document area on the paper and the
upper left corner of the page margins; if negative, then a part of the document is placed within
the upper margin area and is not printed.

[TSLRDE Library Settings] section

BitsPerColor
Integer value from 4 to 7; a number of bits per each basic color that is used when the image
palette is converted to true-color format for processing and converting result back while
storing.

ConversionLimit
Integer value; the code number of color format of image that colors filtering is applied (see
FilterType parameter):

• 0 – do not use filtering at all;

• 1,2 – enables filtering when transforming color and gray-scaled images;

• 4,16– enables filtering for color and gray-scaled 256-palette images as well as for true-
color images;

• 256 – enables filtering only for true-color images;

FilterType
Integer value from 2 to 6; the code number of filter type used while calculating color of each
pixel in image resizing, rotating and calibrating:

• 2 – linear;
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• 3 – cubic;

• 4 – Lanczos;

• 5 – Hamming;

• 6 – Blackman;

[TSLRVC Library Settings] section
For internal use only. Parameters for library TSLRVC.

AutoSelectingSingleFile
Binary value; when set to 1, the single image file is automatically selected for editing
immediately after opening.

BRAOpenOptions
Decimal (without prefix) or hexadecimal (prefixed with 0x) number. Used for control of
document attribute files. Zero or sum of some of the following values:

• 0x0200 - read document attributes from its RLD file (can be used for backward
compatibility);

• 0x0800 - read document attributes from TAF file;

• 0x1000 - do not save document attributes to RLD file;

• 0x2000 - do not save document attributes to TAF file;

For example, setting this parameter to 0x1A00 (which is a sum of 0x1000, 0x0800 and
0x0200) means: “read and write TAF file; read RLD file”. This is the default SuperEdit
behavior.

ClipboardCopyHeight
Height of the document copy in inches for the Copy command.

ClipboardCopySpecHeight
Height of the document copy in inches for the Copy Special and Copy Special To...
commands.

ClipboardCopySpecWidth
Width of the document copy in inches for the Copy Special and Copy Special To...
commands.

ClipboardCopySpecXRes
Horizontal resolution of the document copy for the Copy Special and Copy Special
To... commands.

ClipboardCopySpecYRes
Vertical resolution of the document copy for the Copy Special and Copy Special To...
commands.
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ClipboardCopyWidth
Width of the document copy in inches for the Copy command.

ClipboardCopyXRes
Horizontal resolution of the document copy for the Copy command.

ClipboardCopyYRes
Vertical resolution of the document copy for the Copy command.

ConvertToOneFile
Binary value; setting it to 0 disables creation of the multi-page destination file while converting
multiple input files.

CopyBitmap
Copying data in the Device Dependent Bitmap format to the Clipboard.

CopyDIBitmap
Copying data in the Device Independent Bitmap format to the Clipboard.

CopyEmbeded
Binary value; copying data in the embedded object format to the Clipboard.

CopyLink
Copying data in the link to a linked object format to the Clipboard.

CopyMetafile
Copying data in the MS Windows system metafile format to the Clipboard.

CrosshairVisible
Binary value; setting it to 1 causes SuperEdit to display crosshair at the current cursor
position.

DecPrecision
The option sets the floating-point numbers precision to be used in SuperEdit dialogs.

DefaultVportsOverlapMode
Possible values:

• 0 - overlapping parts of viewports will be painted and printed with white solid brush,

• 1 - overlapping parts are defined by most top defined viewport and only this viewport
should be visible.

DefBmpExt
Bitmap format may have DIB or BMP extension. When the user converts a raster file to the
format, the default extension is chosen.
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DefCalsExt
CALS format may have GP4, CG4 or MIL extension. When the user converts a raster file to
the format, the default extension is chosen.

DefRasterUnits
Decimal value; defines default units for new raster drawings.

DefTCDUnits
Decimal value; defines default units for new TCD documents.

DefVectorUnits
Decimal value; defines default units for new vector drawings.

DefVidarExt
Vidar format may have VID or VIM extension. When the user converts a raster file to the
format, the default extension is chosen.

DefXRes
Default raster image horizontal resolution.

DefYRes
Default raster image vertical resolution.

DelayedClipboardRendering
Binary value; immediate or delayed data rendering for data transfer through the Clipboard.

DitherMode
If this option is checked, SuperEdit uses dithering to improve image colors mapping.

LastSaveDir
Path name to the disk directory of the most recently open file.

LastSaveFilter
File format code number of the most recently open file (this parameter must not be changed).

LastSaveSubFormat
File compression mode code number of the most recently open file (this parameter must not
be changed).

MaximizeApplication
Binary value; setting it to 1 causes SuperEdit to cover the full screen when opened.

MaximizeView
Binary value; setting it to 1 causes the open document window to cover the whole SuperEdit
main window when opened.
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MaxUndoSteps
Decimal value; defines how many undo steps are allowed.

PrintBitmapHeight
This parameters controls maximum height of "tile" used to create printouts.

If the resulting printout will exceed given value in pixels, hole image it will be divided into
smaller tiles.

Value "1024" is suggested for use to ensure proper displaying images on Mobile devices.

PrintBitmapHeight=1024

PrintBitmapWidth
This parameters controls maximum width of "tile" used to create printouts.

If the resulting printout will exceed given value in pixels, hole image it will be divided into
smaller tiles.

Value "1024" is suggested for use to ensure proper displaying images on Mobile devices.

PrintBitmapWidth=1024

PrintToFileWithMargins
This parameter is responsible for printing with or without margin in Print-outs to files (like
PDF or PNG).

Possible values:

• 0 - prints without margins,

• 1 - prints with margins.

Default value is 1 and it's recomended value, especially for printouts from HyperDoc Online.

ShowTwainInterface
Binary value; activates a scanner interface.

TCDSaveMode
Binary value; defines how the SaveAs command works:

• 0 - only the TCD file is saved;

• 1 - subdocuments are copied while saving the TCD file.

TempDir
Path name to the disk directory where temporary files will be created.

ViewBitmapHeight
View bitmap height in pixels.
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ViewBitmapWidth
View bitmap width in pixels.

[TSLTVL Library Settings] section
For internal use only. Parameters for library TSLTVL (cache options).

[Vector Drawing Params] section

Units
Default value of code number of units of vector drawing; one of the following values:

• 1 - inch

• 2 - foot

• 3 - yard

• 4 - mile

• 5 - millimeter

• 6 - centimeter

• 7 - meter

• 8 - kilometer

[Vector Snap Options] section

Pickbox
Size of the pick box, using for snap actions.

SnapActive
If set to 1, vector snap is active.

SnapMode
Needed mode of snap action. Possible values:

• 1 - nearest point

• 2 - end point

• 4 - mid point

• 8 - center point

• 16 - insertion point

• 32 - crossing point
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Appendices

Supported file formats

TesselSoftwareLine Products supports viewing, converting and printing of composite documents
that may contain subdocuments in any of the formats listed below. Editing is supported for
monochrome raster images only.

Format Format
description

Supported
compression modes

Extensions Color Multiple
pages

RLC Run Length Code - RLC - -

TIFF Tagged Image
File Format

Uncompressed

PackBits

LZW

CCITT Group
3 Standard

CCITT Group
3 Modified

CCITT Group 4

TIF ✓

✓

✓

✓

✓

✓

✓

✓

✓

GIF UNISYS - GIF ✓ -

PCX Paintbrush format - - ✓ -

BMP

RLE

Windows bitmap Uncompressed,
RLE4, RLE8

BMP

DIB

✓

✓

-

DMI - - DMI - -

ITI - - ITI - -

CALS - - GP4

GC4

CAL

MIL

- -

VIDAR - Uncompressed

CCITT Group
3 Standard

CCITT Group
3 Modified

CCITT Group 4

Vidar RLE

VIM,VID - -

DCX Fax format - DCX - ✓
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CIT Intergraph G4 - CIT - -

RLE Intergraph

RLE

- RLE - -

IG4 CAD-Overlay Group 4 IG4 - -

DWG* Autodesk - DWG ✓ -

DXF* Standard
vector format

- DXF ✓ -

* - available only when TCD-View application was installed in the system.

Attribute files
CADRaster reads attribute files to obtain information about size, orientation and location of raster
file in world coordinate system. There are four formats of attribute files CADRaster can read and
write:

RLD – CADRaster for DOS attribute file

TAF – Tessel Attribute File

TAB – MapInfo project file.

TFW – ARC/INFO parameter file. File extension may be different depending on raster format.

Raster
file format

Parameter
file extension

*.BMP *.BPW

*.GIF *.GFW

*.PCX *.PXW

*.IG4 *.I4W

*.TIF *.TFW

*.CAL *.CLW

*.JPG *.JGW

*.PNG *.PGW

TAF attribute file
Each drawing file can have an attribute file associated with it, where the drawing’s technical
parameters are stored. It is especially useful to store the parameters that can not be stored in
the drawing file itself due to its format limitations. Some image file formats allow storing more
parameters than others do. The values of image parameters are saved in the image file, if the
image format allows for it, and in an additional parameter file with the same name as the image
file name but with TAF (Tessel Attribute File) extension. The TAF file is located in the same disk
directory as the image file.

Parameters saved in the image file override parameters saved in the additional parameter
file (TAF).
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Creating and using of attribute files can be disabled using the BRAOpenOptions parameter in
corresponding program .ini file (see ).

A TAF file is a text file formatted in sections (like INI files). If the image file is
a multipage raster file, each section describes a separate page. The first page is
described by the [RasterImageParams] section, the second page is described by the
[RasterImageParams.1] section and so on. Parameters of a drawing file in one of vector
formats (DWG or DXF) are specified in the [VectorDrawingParams] section. Thus it is
possible to have two drawing files with the same file name and different file name extensions in
one disk directory: one in raster format and one in vector format and to use a common TAF file
for them. Their parameters are located in different sections of the same TAF file. Vector drawings
use only two parameters: Units and Orientation.

Section name line syntax: [<section_name>]

Parameter line syntax: <Parameter_name>=<Parameter_value>

Parameters description:

Units - the code number of units used to define the insertion point of the image; one of the
following values:

1 inch

2 foot

3 yard

4 mile

5 millimeter

6 centimeter

7 meter

8 kilometer

Color - the color number from the AutoCAD palette (for monochrome raster images only)

Orientation - the image’s orientation. Defined in raster terms (lines and columns of pixels) but
maintaining analogical meaning also for vector drawings. The Orientation can have one of the
following values:

1 first line at the top, first column at the left side

2 first line at the top, first column at the right side

3 first line at the bottom, first column at the right side

4 first line at the bottom, first column at the left side

5 first line at the left side, first column at the top

6 first line at the right side, first column at the top

7 first line at the right side, first column at the bottom

8 first line at the left side, first column at the bottom

See also the picture below for the reference to coresponding above numbers.
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XInsertionPoint - X coordinate of the lower left corner of the image;

YInsertionPoint - Y coordinate of the lower left corner of the image;

XScale - the horizontal scale of the image;

YScale - the vertical scale of the image;

XResolution - image’s horizontal resolution;

YResolution - image’s vertical resolution;

Length - the number of pixels in a single raster line;

Width - the number of raster lines;

Comment - image’s description or a remark text.
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Support for raster drawings in JPEG format

CADRaster recognizes and supports raster drawings stored in popular JPEG format (extensions
JPG, JPEG).

Various parameters that influence compression level, precision of drawing details and processing
time during saving or converting to JPEG format, may be controlled from "JPEG Format Save
Options" dialog called from "Save" tab on "Configuration" dialog.

DCT method

Selects the algorithm used for the DCT step. Choices are:

SLOW: slow but accurate integer algorithm

FAST: faster, less accurate integer method (DEFAULT)

FLOAT: floating-point method

Restart

To emit restart markers in the JPEG file, set one of these nonzero. Set restart interval in blocks to
specify the exact interval in MCU blocks. Set restart interval in rows to specify the interval in MCU
rows. Defaults are zero (no restarts). One restart marker per MCU row is often a good choice.

Smooth

Smooth If non-zero, the input image is smoothed; the value should be 1 for minimal smoothing
to 100 for maximum smoothing. The default is zero.

Quality

Baseline

Constructs JPEG quantization tables appropriate for the indicated quality setting. The quality
value is expressed on the 0..100 scale recommended by IJG. If the baseline parameter is TRUE,
then the quantization table entries are constrained to the range 1..255 for full JPEG baseline
compatibility. In the current implementation, this only makes a difference for quality settings below
25, and it effectively prevents very small/low quality files from being generated.

To learn more about how to use JPEG, see http://www.faqs.org/faqs/jpeg-faq/.

Due to the compression nature used in raster drawings stored in JPEG format, applying some
raster editing operations, like clearing areas or cutting and pasting, may result in some artifacts
inside edited areas, depending on compression parameters used in original drawing.

TSL Color Codes

The image below shows colors available in TSL products. Their numbers are representative to
those present in AutoCAD.
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Note

Please use CHM or webhelp version of documentation to see the table below. It's not
present in PDF due to it's large size.

The table below contains hexadecimal and decimal RGB and BRG codes for the 256 colors in
the Tessel Software Line Programs(numbers 0-255).


